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License & Copyright 

Maxsurf Program  

© 1985-2009 Formation Design Systems 

Maxsurf is copyrighted and all rights are reserved. The license for use is granted 

to the purchaser by Formation Design Systems as a single user license and does 

not permit the program to be used on more than one machine at one time. 

Copying of the program to other media is permitted for back-up purposes as long 

as all copies remain in the possession of the purchaser. 

 

Maxsurf Training Manual  

© 1990-2009 Formation Design Systems 

All rights reserved. No part of this publication may be reproduced, transmitted, 

transcribed, stored in a retrieval system, or translated into any language in any 

form or by any means, without the written permission of Formation Design 

Systems. Formation Design Systems reserves the right to revise this publication 

from time to time and to make changes to the contents without obligation to 

notify any person or organization of such changes. 

 

DISCLAIMER OF WARRANTY 

Neither Formation Design Systems, nor the author of this program and 

documentation are liable or responsible to the purchaser or user for loss or 

damage caused, or alleged to be caused, directly or indirectly by the software and 

its attendant documentation, including (but not limited to) interruption on 

service, loss of business, or anticipatory profits. No Formation Design Systems 

distributor, or agent, or employee is authorized to make any modification, 

extension, or addition to this warrant 
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Learning Maxsurf 

Welcome to Learning Maxsurf. This introductory training manual will give new 

users to Maxsurf a thorough understanding of the applicationôs architecture, 

main functions and give an idea of its capabilities. Experienced users will also 

find this manual useful to expand their understanding of concepts or simply as a 

refresher. 

 

This training manual is by no means an extensive guide to using Maxsurf. If you 

need help or would like more information on certain topics, the manual should 

be consulted. The training manual consists of several short tutorials, each with 

their own concrete learning goal. Throughout the tutorials, the user will model a 

simple hullshape and make modifications to it. Each tutorial may have different 

related resources such as: 

1. Sample designs. Some tutorials will have a ñstartò and ñendò sample 

design attached to it. For example: BasicFairing_start.msd and 

BasicFairing_end.msd. All these designs can be found in the c:\program 

files\Maxsurf\Training Samples directory. 

2. Explanations of background theory. It is recommended to read these 

sections. 

3.  Videos. There are several short videos you can watch that illustrate 

the steps explained in the tutorial.  

a. [Web] You can click on this link for each video to view the 

video online; i.e. on the internet. This will open up the video in 

your Internet browser. You do need a reasonably fast internet 

connection for this. 

b. [Disk] Click on this link from your PDF document when you are 

running this training manual from your local computer. This will 

start up the video from your local hard drive. This is generally 

much faster than viewing the videos online, but it does require 

that you have installed the MSLearning installer. Links to 

ñ[Disk]ò only work from the PDF document and not from your 

internet browser. 

4. Links to the User Manual for background reading on concepts, or further 

explanation of dialogs and related commands. 

 

Tips on using this training material: 

 Take you r time and read all instructions carefully  

 Read explanations, try to understand the concepts explained  

 

 

Start the training by reading ñChapter 1 Maxsurf Helpò.

http://www.fdsfiles.com/training/learningmaxsurf/MSLearning.exe
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Chapter 1 Maxsurf Help 

Before you can start learning how to use the program, it is important that you 

learn what to do when you want more information on using particular commands 

or you need help with a particular feature. Every command in the Maxsurf 

applications is thoroughly documented in the User Manual. This section of the 

training manual describes how to open the manual and find what you are looking 

for. 

Opening the Manual 

You can access the manual from different locations: 

1. From the Windows Start Menu: Programs | Maxsurf | Help 

2. From within the application in the Help menu 

3. From within the application by pressing the F1 function key.  

Note 

In this Training Manual, a vertical bar ó|ô will be used to separate 

menu titles, sub-menu titles and commands in specifying the 

location of a command from a menu. For example, Help | Maxsurf 

Help indicates that Maxsurf Help can be accessed from the Help 

Menu. 

 

Many commands can be accessed from toolbars and via keyboard 

shortcuts (specified in the menus); however in this manual, access 

to commands will be described through navigation of the menus.  

You will need Adobe PDF reader to open the manuals. 

Finding a Topic 

If you have opened the Maxsurf User Manual PDF file, you can search for a key 

word or phrase by clicking on Search from the Edit menu, and following the 

instructions in the Search PDF pane. 

 

You can also use this toolbar button:  or Ctrl+Shft+F .  

Other Resources 

The manual is also available in Adobe Acrobat (PDF) format from the Formation 

Design Systems Support Centre at www.formsys.com/support.  

 

The Support Centre also offers a Knowledgebase which includes Frequently 

Asked Questions and Tips and Tricks databases. 

 

Continue with the Chapter 2 Starting Maxsurf section on the next page.

http://www.adobe.com/
http://www.formsys.com/support
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Chapter 2 Starting Maxsurf 

If you have not already done so,  

ü Install Maxsurf by inserting the CD and running the Setup 

program, and then follow the instructions on screen. 

ü Launch the Maxsurf application on your computer from the strart 

menu.  

You should see something like this:  

 

If you see something completely different:  

ü Close the application and start it again, this time while holding 

down the Shift key.  

This will bring up the following dialog:  

 

ü Clear all Maxsurf Preferences 

Before you can do anything in the application, you either have to start a new 

design or open an existing design. 
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Continue reading the Opening a Design section. 

Opening a Design 

Opening a Design - Concepts 

A Maxsurf file has a .msd file extension and can be recognised by the  file 

icon. As in most Microsoft Windows applications, you can open files in different 

ways. For example, you can open files by double clicking on them or by using a 

File | Open menu. Letôs have a look at the different ways you can open a file in 

Maxsurf. 

Opening a Design ï Video 

 Watch a short video that shows you how to open a design in Maxsurf using 

the File | Open method and the drag and drop method. [Web | Disk] 

Opening a Design ï Procedures - File | Open  

File | Open 

Probably one of the most conventional ways to open a file is by: 

ü Start the Maxsurf application 

ü Click File | Open Design 

ü Navigate to the Maxsurf program file directory . 

This is C:\Program Files\Maxsurf, unless you have specified it differently. 

ü Open the Sample Designs folder 

 

ü Select the design called Maxsurf Sample_Trawler.msd and open 

it. 

Done! The design will initially be displayed in each of the four view windows by 

the outline of its surface edges (in the case of the Sample Trawler, there is only 

one surface), represented as solid grey lines. 

 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/opening-a-design#-6AJ-RR6UrmSYZ7mGOTegA
TrainingVideos/OpeningDesignP.avi
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Note 

All Maxsurf applications have the ability to open different sets of 

data. For example in Maxsurf you can load Markers or surface 

models. The type of data that can be opened is determined by the 

Window that you have currently got ñactiveò or ñfrontmostò. You 

will learn about the different Maxsurf Windows later. 

Opening a Design ï Procedures - Double Click 

Double Clicking on a File 

ü In Windows explorer, navigate to  

c:\program files\Maxsurf \Sample Designs 

ü Double click on the file called Maxsurf Sample_Trawler.msd 

This will start up a new Maxsurf application and bring up the following dialog 

first: 

 

ü You can select the Workshop Library.wsl or hit Escape to skip 

this step. 

The Workshop Library is only used in case you wish to allocate material 

properties (eg. material and thickness) to a surface in Maxsurf and will not be 

needed during the LearningMaxsurf training. 

Opening a Design ï Procedures ï Drag and Drop 

Drag and Drop 

One of the less known options is that you can actually drag a .msd file onto any 

of the View windows of the Maxsurf application.  

ü Close all applications you may have open on your computer, so 

that you donôt get confused with the next few steps. 

ü Start Maxsurf  

ü In Windows explorer, navigate to  

c:\program files\Maxsurf \Sample Designs 
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ü Hold down the left mouse button after clicking on the Maxsurf 

Sample_Trawler.msd once. 

ü Now drag and drop the file into any of the View windows in 

Maxsurf:  

 

Dragging and dropping the file from Windows explorer window into one of Maxsurfôs View windows. 

 

Continue with the section on Closing a Maxsurf Design. 

Closing a Maxsurf Design 

You can close a design from the File menu:  

ü File | Close Design 

In case there have been any changes to the model since you have last saved it, 

Maxsurf will ask you whether you wish to save the design changes. 

 

 Selecting yes will save the changes and clos e the model.  

 Selecting no will not save your changes and close the design. You will lose 

all changes since the last save.  

 Selecting cancel will cancel the close design command and allow you to 

continue working.  

 

Continue with the Chapter 3 User Interface section on the next page.
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Chapter 3 User Interface 

In this training manual it is assumed that the user has a reasonable familiarity 

with working in applications on any Microsoft Windows
®
 operating system. 

Some Maxsurf specifics to the User Interface are described below. It is a good 

idea to read this section before you start modelling, as it will give you a good 

understanding of the architecture of the application which helps you find 

commands faster and operate the program more efficiently.  

 

The User Interface can be defined as the aggregate of tools available that 

allow you to work with the application. Some of these tools can be used for 

viewing while others allow you to control or manipulate the object being viewed.  

 

The Maxsurf User Interface can be divided up into three main groups: 

 Menus  

 Toolbars  

 Windows  

Menus 

Unlike some other CAD applications Maxsurf does not have a command line. 

This has the advantage that you donôt have to memorise different commands and 

everything can be done using the commands in the menus.  

 

To enable faster access to the menu commands Maxsurf has two other options: 

1. Toolbars. The most common commands can also be accessed through 

toolbars.  

2. Additionally, Maxsurf has several object based right click commands. 

This means that after selecting an object and using the right mouse 

button, Maxsurf displays the most commonly used commands on the 

selected object. For example, when you select an edge of a surface and 

right click on it, you can access the Surface Properties or perform a 

trimming operation on the surface.  

These are just other (usually more efficient) ways to get to a corresponding menu 

command. 

 

The menus and toolbars in Maxsurf operate in the same way as most Microsoft 

applications and will not be explained any further. At this stage it is not required 

to know all the menu commands as we will cover most of them as we go along in 

this training manual, but for the interested reader the function of each Menu 

command is explained in detail in the Menus section of the Reference Chapter of 

the Maxsurf manual. 

 

A brief overview of the menus is worth studying: 

 

Menu Description 

File  Working with the file 

Edit Copy & Paste and other editing commands 

View Lets you set how you want something displayed. Often 

confused with the Display menu. 

Markers All commands to do with Markers 

Controls All commands to do with Control Points 



 18 

Curves All commands to do with Curves 

Surfaces All commands to do with Surfaces 

Display Select what you want to display 

Data All commands to do with calculations & producing data 

Window Different window display options 

Help Accessing different Help resources 

 

Toolbars 

The toolbars contain toolbar buttons that activate menu commands. Only the 

most commonly used menu commands are on the default toolbars. Maxsurf 

allows you to create you own toolbars and toolbar buttons. This is not covered in 

the LearningMaxsurf training manual. For the interested reader: information on 

this can be found in the Customising Toolbars section in the Maxsurf Reference 

chapter. 

Windows 

Continue reading the Maxsurf Windows section of this training manual. 

Maxsurf Windows 

Maxsurf consists of a total of 10 windows. Each window has its own 

functionality and usefulness depending on the task that you want to perform. 

You will rarely need all 10 windows at the same time. For example: when you 

are working with Offsets or when you are modelling, there is little need for the 

Calculations window. The Calculations window can then be minimised or closed 

to optimise available screen space. 

 

Within the 10 Maxsurf windows we can identify a group of 4 ñView Windowsò 

that are used to view the model. 

 

Continue reading the 3D Modelling in 4 View Windows section. 

3D Modelling in 4 View Windows 

One of the most difficult things to learn is working in a 3 Dimensional 

environment on a computer screen. Especially if you have never used 3D 

drafting tools before it can take some time to get used to. The Maxsurf 

application is specially designed to help you manipulate a shape in 3D using just 

your mouse and the computer screen display. The tutorials in this document will 

teach you different mouse techniques and screen display settings that increase 

your 3D modelling efficiency in Maxsurf. 

 

Maxsurf consists of four view windows. For each 2D view direction, Maxsurf 

has one window: 

View direction View Window 

Looking from the stern to the bow Body Plan Window 

Looking from the Starboard side Profile Window 

Looking from below* Plan Window 
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* This may appear odd, but this way the user can model above the centreline in Plan view. Research 
has shown that a naval architect can interpret the shape of a vessel in plan view better when it is 

drawn above the centreline. 

 

Body Plan Window 

 

Profile Window 

 

Plan Window 

Finally Maxsurf has a 3D viewing window that allows you to view the model in 

3D, rotate it and render it. This is called the Perspective Window. 

 

Perspective Window 

Continue with the section on Working in Different Windows Layouts. 

Working in Different Windows Layouts 

Window Layouts - Concepts 

Most computers use a 1024 x 768 resolution monitor which means that there 

is limited space available and you continuously have to find a compromise 

between the number of windows you have open and the size of the windows: 
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5 windows open, but each of them is quite small. 

 

Only one window open (Body plan), but now you canôt see the effect of a  
modification to the shape of the design in the Profile, Plan or Perspective window. 

It is really a matter of experience and personal preference what suits your 

working methods best. Here are some tips from the Maxsurf developers: 

Window layout tips:  

- To maximise screen space, it is recommended to maximise the 

Maxsurf application window at all times. 

 

- When modelling, close all windows except for the view windows.  

 

- When modelling, switch between working with 4 view windows 

and just one view window. 

 

- Minimising the amount of information on your screen helps you 

work more efficiently. 

Windows Layout ï Video 

 View a video that shows you the different windows layouts in Maxsurf as 

well as different ways to switch between windows (next section). [Web | Disk] 

Windows Layout ï Procedures 

In the following steps you will learn how to setup your windows layout in 

Maxsurf so that you have just the 4 view windows open. 

ü Start Maxsurf while holding down the Shift key 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/working-in-different-windows-layouts2#CuAwl8tOgsOOGH8gIlNsLQ
TrainingVideos/WindowLayoutP.avi
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ü Select ñyesò to clear all preferences 

This will start Maxsurf with the default windows settings: 

 

ü Use Window | Tile Horizontal 

Youôll see something like this: 

 

Maxsurf windows after Tile Horizontal 

ü Now close all windows except for Body Plan, Profile, Plan and 

Perspective 
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Notice how the closed windows are all stacked at the bottom of the Maxsurf 

application window: 

  

ü Do another Window | Tile Horizontal 

You should now see something like this: 

 

You can re-open any of the closed windows by simply selecting the window 

from the Window menu and the selected window will restore to its original 

position and size before it was closed. 

 

Continue with the Switching Between Windows section. 

Switching Between Windows 

Switching between windows ï Concepts 

A Window can be either in the background (passive/display only) or it can 

be the ñcurrent windowò. A background window is a passive window used for 

display only and you can not type or modify any of the objects in it. Only one 

window can be the current window or active window. In this active window 

objects can be modified (eg. change surface shape or text in a table). 

 

You may click within any window to make it the active window. If you have 

several windows open, you can recognise the active window by the brighter 

colour of the title bar. A window may also be brought to the top by selecting its 

name from the Windows menu. 

Switching between windows ï Procedures 

ü Start Maxsurf while holding down the shift key 
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ü Click yes to clear all saved Preferences 

In the images below the Maxsurf Sample_Trawler design is used. 

 

ü Maximise the perspective window by clicking the  button in the 

top right corner of the window. 

 

This will maximise the Perspective window inside the Maxsurf application 

window: 

 






































































































































































































































































































